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About the Tutonial

Analysis Edition for OLAP, the business intelligence reporting tool, is a part of SAP
BusinessObjects product suite. This is a handy tool for business users for analytical and
ad hoc reporting. Using this tool, business users can create basic, medium, and complex
reports from transactional data available in OLAP data sources such as SAP BW and HANA
to meet the business requirements. This tutorial explains the key concepts of SAP BO
Analysis Edition for OLAP.

Audience

This tutorial is designed for all those readers who want to learn the basics of SAP BO
Analysis Edition for OLAP and implement it to analyze data with the help of this tool.

Prerequisites

You need to have the required skills to unearth relevant data and analyze it in order to
create professional Business Intelligence reports. You should have a basic understanding
about OLAP data sources such as SAP Business Warehouse, HANA Modeling views, etc.

Disclaimer & Copyright

© Copyright 2018 by Tutorials Point (I) Pvt. Ltd.

All the content and graphics published in this e-book are the property of Tutorials Point (I)
Pvt. Ltd. The user of this e-book is prohibited to reuse, retain, copy, distribute or republish
any contents or a part of contents of this e-book in any manner without written consent
of the publisher.

We strive to update the contents of our website and tutorials as timely and as precisely as
possible, however, the contents may contain inaccuracies or errors. Tutorials Point (I) Pvt.
Ltd. provides no guarantee regarding the accuracy, timeliness or completeness of our
website or its contents including this tutorial. If you discover any errors on our website or
in this tutorial, please notify us at contact@tutorialspoint.com.
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1. SAP BO Analysis — Overview

Analysis edition for OLAP is a BI reporting tool using which you can connect to OLAP data
sources. It helps business managers in decision making, and to analyze business data.
You create a new workspace, then add charts and crosstab objects and OLAP data sources
to get the data into these objects.

In Analysis edition for OLAP, you can connect to multiple data providers simultaneously.
For example, you can have a workspace where data comes from SAP BW cube and also
from Microsoft Analysis Cube.

This tool can be accessed via BI Launchpad in a web browser using the following link -

http://localhost:8080/BOE/BI

In the above link, localhost represents the Name of BI server. When you have BI server
on the same system on which you are trying to access BI Launchpad, you can use the
local host in the URL, otherwise you have to mention the name of BI server to open BI
Launchpad.

E_l_-_;* bz ki ] PRk B Pt | - b1 lanch pad ] I
:.I - ' Welrome: dema Prfaees  Hdp migin ¥ L T
[
=
+ My Hroosty Vicwed lommesks = & unnead mesages in Py Inbox * My Applicalioas
18 iep Ly iEwe] doluriest T et iEBE AR
,).-.
35
ihat
S e
= My Rroestly Run Dooument = @ linevsd Alerin :;
" Pt Regen Mo i erts
G8 pusieh Repert
S pyndeh Regen o=l
4B workd Sabes Fapert H“"
Sem fHe..

To open the application, navigate to Applications dropdown at the top of the screen. You
can see Analysis Edition for OLAP tool in the dropdown list.
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http://localhost:8080/BOE/BI

P g laundh pad x | |
Welcome: demal | Applications+  Preferences Help m
3 Analypisaditios £ oy an
: Dpen the Applications mer

Crystal Reports for Entarprise .
¥

* 0 unread messages in My Inbox
#4i  Information Steward
uments Mo unread messages » Module

Web Intelligence

You should have tool installed on SAP BusinessObjects server and a connection from the
local system to BI platform. You can also access SAP BO Analysis for Microsoft Office,
which integrates Analysis with Microsoft Excel and PowerPoint.

S0P Business Inteligence
Control Panel
. S0P BusinessObjecks Analysis
|; Analysis for Microsoft Excel — |pevices and Printers
& Analysis for Microsoft PowerPoink

| SAP BusinessObjects BI platform 4 Adminiskrative Taals »

| SAP BusinessObjects BI platform 4 Clien

| SAP BusinessObjects Dashboards 4 Help and Support

| SAP BusinessObjects Design Studio

| SAP Crystal Reports 2013 x| Run..
N Back Windows Security
Seatch programs and files E]J Log off | ¥

- & & - Blala]e

All the connections and Analysis workspaces are managed in Central Management Console
(CMCQ). You can distribute Analysis workspace to large number of users over the web.

What is an OLAP Data Source?

A relational data source contains data in one format and to meet the business
requirements, you need to create a multidimensional product. OLAP data represents the
hierarchical aggregations of the individual transactions. Aggregated data can be analyzed
much faster than relational data.

OLAP data source also allows hierarchy of data where you can drill to different data levels.
OLAP data model is also called a data cube.

@' \tutorialspoint
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Time

Region

Product

Using a data cube, you can analyze the data in different ways to meet different business
requirements. In the above cube, you can analyze -

¢ How are products selling at different times of year? (Product by Time)
e How are products selling in each region? (Product by Region)

e How are products selling in each region at different times? (Product by Region
and Time)
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2. SAP BO Analysis — User Interface

When a new workspace is opened, you can see different icons and panels in the user
interface. Analysis Edition for OALP tool can be opened via BI Launchpad.

if::_-;f = |“P htkp: fflocalhosk: S050/ECOE BT A

[m][[flunﬂﬂsuﬂmﬁnahsiSMp... R

DE—C"--|lev||’i_:‘.v|§"ﬁ_/Analvze|/Insert|/Display|
’:l')"| e | M3 | X ™ | F Filter - 51 Sort ~ [B cCalculations - [y Conditions

]| oote - «
[ &4 & ‘i] Prompts 1] Columns ||]["] Drop Colu

When a new workspace is created, you have to select the data source. It shows you a list
of all OLAP connections to different database. Once you select the connection, you will be
prompted to select an OLAP model.

Following panels are available under the user interface -

e Task Panel

e Layout Panel

e Metadata Explorer
e Analysis Window

e Crosstab

e Chart

' tutorialspoint
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81 launch pad - Windows Internet Explorer

HE
@__‘ ) % [P hitpsjtocaihast-a0ag/eceier O] *2 [ K| P e lounch pad x A
Wielcome: hanauser | Applications»  Preferences  Help menu~ Log off
®
| Home | Documents | New Analysis Worksp... g
D& 3-| @t - #nalyze ‘ Insert | Display |
Task Panef
o o [P B E X i Fited- 5} Sort - [ Calculations ) Conditional Formatting Analysis Panel 2 Auto Upd
E?_‘ & & Q) prompts Il columns ] orop Columns
%) | _Lumira_Dataset/Lumira_Daaset [OLAP_F - = Drop Raws
E_U Cross Tab
I
T
= | “Metadata
E7% Measures  Explorer =0TS
Salary LayouflPanel
Bonus
Annual Bonus
Annual Bonus
Bonus
EMPID
i _ .
1 NaE 7" Background
PHONE
Salary
Chart
|
@ o = [P hitpif locahost: 5080/E0E (BT O] [*##/ % | |8 o1 launch pad x | |

&

Welcome: hanauser | Applications»  Preferences

Home || Documents ” New Analysis Worksp... [ ] ]
] = - | =3 - | - = I Analyze | 7 Insert | Display |
o o | g @ @) X D Bl - il - 22 @ E . : OtherCharts ~ | Switch o] ~
& & D prompts 1l © Measures
“' _ Lumira_Dataset/Lumira_Daaset [OLAP_F ] * Measures NAME PHONE Salary
;—u EMPL 12356 2,000.00
Result 2,000.00
= EMP2 45678 3,000.00
s
= | Result 3,000.00
=74 Measures = Rows EMP3 34556 4,000.00
Salary NAME Result 4,000.00
Bonus PHONE EMP4 46557 2,500.00
Annual Bonus Result 2 connn
Annual Bonus LI —.I
Bonus e
EMP ID
. _ 00
NAME i+ Background 20.45 % 08 %
PHONE -
Salary 13.64 %
18.18 %
21.2T %
11.36 %
Salary

At the top, you have the task panel where you can perform different operations - Creating

a new workspace, Open option, Save Option. You can even change an OLAP connection or
remove a connection in the workspace.

On the left side you have a metadata explorer, where all the objects from OALP data source
is displayed. You can see different measure and dimension values.

In the middle pane, you have the Layout option, which defines the layout of Crosstab. You
have to drag different measures and dimensions to the corresponding columns and rows.

You can use the Background option to filter the data in background based on Dimension
values.

w ' tutorialspoint
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Analysis 1
1l Columns Measures Bonus
7~ Measures Salary
% Bonus PHONE 200 Result
12356 2,000.00 2,000.00
Total Result 2,000.00 2,000.00
= Rows
“ PHONE
Al =

7~ EMP1 (MAME)

100 %

Salary [ 200

In the right pane, you have Analysis Panel, Crosstab, and Chart. Crosstab and Charts are
based on the values selected in the Layout panel.

In the Analysis panel, you have 3 tabs -
e Analyze — Under the Analyze tab, you have an option to apply Filter and Sort.
e Insert — Under the Insert tab, you can add Crosstabs and insert different type of charts.

e Display — Under the Display tab, you can manipulate data under crosstab. You
can swap axis, create sub-analysis, define nulls and zeros, etc.

[

- - & F - " Other Charts « | Switch to | =
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3. SAP BO Analysis — Create a Workspace

To create a new workspace, you have to click the New button - Create a new workspace.

SAD4

Home | Documents | New Analysis Worksp... = = = |
Eﬁvl[ﬂvlgvlé'gﬁ_/Allﬂhl'ZE|/Insert|/Displayr|

. L ; u]
“lcreate a new wnrkspacer% | X F Filter - 3 Sort -

Data ~ < N Lavout % 1 Analysis 1

When you click the New button, you will be prompted to select a data source. You can
select from the dropdown list to view all the connections or the connections pointing to
Cube/InfoProvider or to Query/Query View to connect to BW OLAP source.

Open Data Source :-

Show Connections: | Cube / InfoProvider - |
All
Mame System fiption
Cube  InfoProvider
e Con_HAMA Query / Query Wisw w OLAP Cdnm
e HAMNA_COM_UMESH HAMNA_CON_UMESH
W HAMA_OLAP OLAP Connection for HAMA
e HANA_OLAPConn_Manas_Rizwan_Um... HAaMNA_OLAPConn_Manas_Rizwan_Umesh
i KRISH_PRACTICE OLAP Connectionl
W SALES RESOURCE
e SAPBW_GIRI
W YOLAP UMNIVERSE_01_ISH Universe-Qlap Con for HANA Data
W YOLAP UMIVERSE_01_ISH Universe-Olap Con for HANA Data

4+ Back Mext oK

When you select “All” from the dropdown list, you can see -

e OLAP Connections
e Cube/InfoProvider

e Query/QueryView

w ' tutorialspoint
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Click the Next button and you will see a list of all the Modeling Views/InfoCubes in the
source system that are pointed using this OLAP connection.

Open Data Source = ﬁ

Show Connections: | All -
Mame Drescription
@ Con_HAMA HAMA OLAP Conn -
[ DesignStudio_hana_cennection
[J hana_arshivan
# HAMNA_COM_UMESH HAMA_COMN_UMESH
@ HAMNA_OLAP OLAP Conmection for HANA
@ HAMNA_OLAPConn_Manas_Rizwan_Um... HAMSA_QOLAPConn_Manas_Rizwan_Umesh
4 KRISH PeaCTICE Ol a8 Connsction

CQLAP Conneciton to connec to SAP HAMNA

SALES_RESOURCE

-

@ sAP BW_WIPRO BW

# SAPBW_GIRI

[0 saPBW_WIPRO SAP BW

o WIPRO_OLAP_EW

@ YOLAP _UNIVERSE_D1_ISH Universe-0Olap Con for HANA Data

¢ YOLAP_UNIVERSE_O01_ISH Universe-Olap Con for HAMA Data 7
Back X 13 0K Cancel

Navigate to Folders tab at the top. You can also perform a search with the name of
InfoCube/Modeling View in the source system.

Select InfoCube from the source system and click the OK button.

EIMPLYEAEYLEARHNING
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Open Data Source

|
~— Find

Wiews: All

I 1harinor
IC=) sPRA

Folders ‘

_ lLumira_Dataset

=

i _Lumim_DataseﬂLumim_Daasetg

E !

L A_KRIS

[ AD

l,—;{ _B36_SALES
[y _Rudram
IC=) _SALES19
I _zzz00z00

IC) A1_SALES
[T A1_SALESZ
L) A1PACKAGE

[C=) ABDULLA_PACK
[C3) ABHISHEK

4

Back

Mext | k O

Cancel

When you click the OK button, all the measures and dimension values will
metadata explorer under the new workspace. You can see the name of InfoCube/Modeling
View under Data tab in the Task panel.

be added to

You can drag different measures and dimension values to the Layout panel to create a
Crosstab and Chart in the Analysis pane.

Home | Documents | New Analysis Worksp... 7 = © |
De. 3.1 8.1&-5 ¥ Analyze | sert | Display |
o ool BB X 7. b - 2 (@ E - 1 other Charts - | switch to B 2 o Upd
4 & @ pompts 1] columns Measures
|
~|| _Lumira_pataset/Lumira_Daaset [OLAP_f - | 7 Measures NAME Salary Bonus
= EMPL 2,000.00 200.00
EMP2 3,000.00 300.00
= EMP3 4,000.00 400.00
7
) | EMP4 2,500.00 250.00
Measures = Rows EMPS 6,000.00 500,00
Salary NAME EMPG 4,500.00 450.00
Bonus Total Result 22,000.00 2,200.00
Annual Bonus
Annual Banus ] O
Bonus B =
EMPID n r
" =
Hate T Rockgreund II L | L |
PHONE e
Salary
2045 % 2045 %
1364% 13.60% e
EMP)]
Emp3|
y ” Empg|
p— 1848 % p— 1818 % -
EMP|
Salary Bonus
| D tutorial int
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Adding Chart to WS

To add a chart to workspace, you have to navigate to the Insert tab at the top. You have
different chart options under Insert. When you have multiple analysis on the sheet, each
chart points to a specific analysis in the workspace.

Adding Chart

In the analysis window, you have to select the component that you want the chart to be
linked to -> Navigate to Insert tab and select the Chart from the available charts.

This will add the chart as a sub-analysis, linked to the component that you selected. The
added chart is placed below or to the right of the existing components on the sheet.

Analyze I Insert | Display I

Following chart types are available under the Insert tab in the tool -

e Column Chart Family
e Multiline Chart

e Multi Pie Chart

e Bar Chart

e Other Chart

I [l
1l columns Measures
. NAME Salary Bonus -
M
Edsures —
EMPL 2,000.00 200.00 7,000-
EMP2 3,000.00 300.00 i
' 6,000 W EMP1
EMP3 4,000.00 400.00 5,000- -
EMP4 2,500.00 250.00 4,000- EMP3
= Rows EMP5 6,000.00 600,00 3,000 EmPa
HAME EMPg 4,500.00 450,00 2,000- R —
Total Result 22,000.00 2,200.00 1,000~ m EMP§
0- - - ——— —
ﬂ J Salary Bonus
{ 4 n - | = p— =
r r ] 1
7" Background I ‘ ‘ I | -
—
Bonus |
. W EMP1
2045 % 20,45 % m EMP1 r EMP2
s ’ 1364% ’ 13.64% ewpz | I EMP3
EMP3 I £e
Pp— BA% 37575 1848 % ey || B EMPS
Salary | EMPE |
W EMPS I
Salary Bonus EMPS F
I— 0 1,000 2,000 3,000 4,000 5000 6000 7,000
x =

'@j ' tutorialspoint

EIMPLYEAEYLEARHNING



Adding Crosstab to WS

In Analysis Edition for OLAP, you can add a crosstab as Analysis or Sub-analysis. To add
a crosstab as sub-analysis, navigate to the “Insert” tab at the top of the screen.

Analyze ' Insert | Display '
Bl - b - 2 @ E . * othercharts + | Switchto dlll ~
Insert a new analysis
Insert a sub-analysis I
T Columns Measures
- Measures NAME Salary Bonus
EMP1 2,000.00 200.00
EMPZ 3,000.00 300,00
EMP3 4,000.00 400.00
..... EMP4 2,500.00 250,00
= Rows EMPS 6,000.00 600.00
MAME EMPG 4,500.00 450.00
Total Result 22,000.00 2,200.00

This adds a crosstab as a sub-analysis, linked to the component that you selected. The
crosstab is added to the right or below an existing component.

When you add it as sub-analysis, it is based on the existing object in the workspace. When
you add it as a new analysis, it adds a blank crosstab below or right of an existing object.

11

w ' tutorialspoint

EIMPLYEAEYLEARHNING




\nalyze | Insert | Display |
=53] Ll - 2 @ [E - 1 Other Charts ~ | Switchto dlll -
Analysis 1
[l columns Measures
NAME EMP ID Salary Bonus
EMP1 1234 2,000.00 200.00
Result 2,000.00 200.00
EMP2 1235 3,000.00 300.00
_____ Result 3,000.00 300.00
= Rows EMPZ 1236 4,.000.00 400.00
Result 4,000.00 400.00
EMP4 1237 2,500.00 250.00
Result 3 O EM
KN 2
[l Drop Columns
7t Background = Drop Rows
KN I
sheet 1 Shest 2 | Sheet3 | _"|

How to Copy an Existing Crosstab or Chart?

It is also possible to copy an existing crosstab or chart. To copy an object, you have to
select the object by clicking the Analysis panel. Later, click the Copy button at the top.

12
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[ —
m Documents | New Analysis Worksp... .~ = £ ]
] = o | o - | I - T fnalyze | 7 Insert | Display |
o o | B[R B X | 1. i - & @ E - 2 OtherCharts - | Switchto il ~
II“ |Copy the selected crosstab or chart] |
—
— 4 # Prompts Il columns Measures
=B __Lumira_Dataset/Lumira_Daaset [OLAP_I-;I “ Measures NAME EMP ID Salary Banus
= EMP1 1254 2,000.00 200.00
Result 2,000.00 200.00
= EMP2 1235 3,000.00 300.00
*
= [ % . Result 3,000.00 300.00
7%, Measures = Rows EMP3 1236 4,000.00 400.00
Salary NAME Result 4,000.00 400.00
Bonus EMP ID EMP4 1237 2,500.00 250.00
Annual Bonus Result 2,500.00 250.00
Annual Bonus EMPZ 1101 6,000.00 500.00
3 :
: Bonus i / Result 6,000.00 600.00
Y
Ewpo EMP& 1501 4,500.00 450.00
NAME 3
g PHONE 1" Background Result 4,500.00 450.00
Total Result Result
PHONE 22,000.00 2,200.00

When the object is copied, you can paste this to a new sheet. To paste the object, you can
use the paste button at the top of the screen. You can also copy the object on the right or
below an existing object.

Home || Documents || New Analysis Worksp... - = & |
[} SR |~ 1 | & - & s Analyze | 7 Insert | Display |
w o | Be | m|[G&]] x| ™ Bl - b - x2 @ [E - i othercharts ~ | Switch to il -
Ell [Faste the copied crnsstal:: or chart | |
= & & D prompts 1l Cotumns Measures
=T __Lumira_Dataset/Lumira_Daaset [OLAP_}—;I “ Measures NAME EMP ID Salary Bonus
;]] EMP1 1234 2,000.00 200.00
= Result 2,000.00 200.00
=l EMP2 1235 3,000.00 300.00
=K s | s Result 3,000.00 300.00
= Measures = Rows EMP3 1236 4,000.00 400.00
Salary MNAME Result 4,000.00 400.00
Bonus EMP ID EMP4 1237 2,500.00 250.00
Annual Bonus Result 2,500.00 250.00
Annual Bonus EMPS 1101 6,000.00 500.00
Bonus : : Result 6,000.00 600.00
E::éD _-— e EMPE& 1501 4,500.00 450.00
= BHONE 1" Background Result 4,500.00 45000
PHONE Total Result Result 22,000.00 2,200.00
= salary
Salary
ET| A
Sheet1 ||| Sheet2 | sheets | [

If you want to delete the component, you can click the cross button on the top right corner
of the object.
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Il Cotumns Measures
- Measures NAME EMP ID Salary Bonus

EMPL 1234 2,000.00
Result 2,000.00
EMPZ 1235 3,000.00
» Result 3,000.00
= Rows EMP3 1236 4,000.00
NAME Result 4,000.00
EMP ID EMP4 1237 2,500.00
Result 2,500.00
EMPS 1101 6,000.00
Result 6,000.00
» EMPE 1501 4,500.00
T+ Background Result 4,500.00
Total Result Result 22,000.00

200.00
200.00
300.00
300.00
400.00
400.00
250.00
250.00
600.00
600.00
450.00
450.00
2,200.00

x

elete Analysi

Saving a Workspace

You can also save the workspace to BI platform repository. You can choose to save your
changes to the existing workspace, or to save the modified workspace as a new workspace

in the repository.

SAR4

Welcome: hanause

Home || Decuments | New Analysis Worksp... £ l
0 = . > - | B . - 59 Analyze | 7 Insert | Display |
=) | EJ 2::: As... X [ Ej [ R - I: + 11 Other Charts - | Switch to il ~
g & & G prompts [ll columns Measures
—G) __Lumira_Dataset/Lumira_Daaset [0LAP_I-;| “ Measures NAME EMP ID Salary Bonus
::_IJ EMPL 1234 2,000.00 200.00
= Result 2,000.00 200.00
= EMP2 1235 3,000.00 300.00
=iy R | Result 3,000.00 300.00
=7 Measures = Rows EMP3 1236 4,000.00 400.00
salary MAME Result 4,000.00 400.00
Bonus EMP ID EMP4 1237 2,500.00 250.00
Annual Bonus Result 2,500.00 250.00
Annual Bonus EMPS 1101 £,000.00 &00.00
Bonus Result 6,000.00 600.00
E:;;D —— EMP& 1501 4,500.00 450.00
5 % PHONE " Background Result 4,500.00 450.00
PHONE Total Result Result 22,000.00 2,200.00

In the next window, you have to select the folder where you want to save the Workspace.
Enter the name of the Workspace and click the Save button.

tutorialspoint
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Save

My Documents
¥ ey |

~WebIntelligence

[

41_SALES
BAL_Sales [MIMEs)
basic {MIMEs)

demo (MIMEs)

*
\’,If

Title «
~WebIntelligence
A1 SALES
BAL_Sales (MIMEs)
basic {MIMEs)
demo (MIMEs)
gopi

1SH-Analysis Workspace

[
X

1 |of2Z+ p» M

gopi — KRISHMNA

I5H-Analysis Workspace majed folder

KRISHMA PER_GIRI

majed folder ;I
Folders
File Mame: [Test
Save As Type: I.b.nal'y'sis Werkspace =1

»
Save | Cancel |

Note: In Analysis Edition for OLAP, if a workspace is idle for several minutes, a copy of
the workspace is automatically saved to your Favorites folder before the session is

terminated.

When the session is returned before it is terminated, the auto-save cycle is reset, and the
workspace is auto-saved again the next time your workspace becomes idle for several

minutes.
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End of ebook preview
If you liked what you saw...

Buy it from our store @ https://store.tutorialspoint.com
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